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1.  INTRODUCTION  

Large area, high-resolution, three-Dimensional (3D) mapping of the Martian surface is not 
only essential for performing key science investigations of the generation and evolution of the 
planet’s surface, but also critical for supporting existing and future surface robotic missions as 
well as human exploration. Over the past 20 years, 3D mapping of the Martian surface has only 
been done for larger areas with lower-resolution data, or for small areas with higher-resolution 
data. 
 
The large area lower-resolution 3D mapping work usually uses the ESA Mars Express’s High 
Resolution Stereo Camera (HRSC) data at 12.5–50m/pixel producing photogrammetric digital 
terrain models (DTMs) at 50–150m/pixel or uses the Mars Reconnaissance Orbiter (MRO) 
Context Camera (CTX) data at 6m/pixel producing DTMs at 18–24m/pixel where such 
serendipitous stereo coverage exists and the images are of a suitable quality to process stereo 
photogrammetrically.  
 
On the other hand, small area high-resolution 3D mapping work usually employs the MRO 
High Resolution Imaging Science Experiment (HiRISE) data at 0.25–0.5m/pixel producing 
DTMs at 0.75–2m/pixel using photogrammetry or DTMs at 0.25–0.5m/pixel using 
photoclinometry, or uses the ExoMars Trace Gas Orbiter (TGO) Colour and Stereo Surface 
Imaging System (CaSSIS) data at 4–6m/pixel producing DTMs at 12–18m/pixel using 
photogrammetry or at 4m/pixel using photoclinometry (at the pixel-level) or at 1m/pixel using 
super-resolution restoration assisted photoclinometry (at the sub-pixel level) (Tao et al., 
2021a). 
 
The limitations of having to trade-off between “large area” and “high-resolution”, for Mars 3D 
mapping is a consequence of three different aspects. Firstly, lower-resolution data such as 
HRSC has better stereo coverage as it is inherently a stereo mapping instrument, whereas the 
main high-resolution data to date (HiRISE) is only capable of targeted stereo. Secondly, the 
photogrammetry and photoclinometry processes are complex and subject to different errors 
(or artefacts) at each of their different processing stages, which require specialist expertise to 
deal with these complexities in order to produce high-quality DTM products, especially over 
large areas. Thirdly, the expensive computational cost from existing photogrammetry and 
photoclinometry pipelines makes it extremely difficult to achieve large area high-resolution 
coverage. Other UCL DTM datasets published here have employed the CASP-GO (Tao et al., 
2018) to produce extensive HRSC DTM datasets (Tao et al., 2021b). 
 
In this work, we experiment with a previously developed single-input-image fast DTM surface 
modelling system, called MADNet (Multi-scale generative Adversarial u-net with Dense 
convolutional and up-projection blocks) (Tao et al., RS, 2021c), exploring large area high-
resolution DTM production using a set of co-registered HRSC-CTX-HiRISE images that are 
co-aligned with the global reference DTM from the Mars Global Surveyor’s Mars Orbiter Laser 
Altimeter (MOLA) (Tao et al., RS, 2021d). In contrast with traditional photogrammetric 
methods, where two overlapping images (with a suitable stereo angle, typically ≥8˚) are used 
as inputs to derive the DTM, MADNet requires only a single image as input to derive a DTM, 
firstly in relative values (normalised), and then by using a referencing coarse resolution DTM 
(e.g., the globally available MOLA DTM) to produce the final DTM product. It should be noted 
that the referencing basemap DTM is usually sourced from photogrammetric methods because 
the initial surface heights, triangulated from the relative image disparities, are generally 
considered imprecise and are required to be corrected using a reference DTM (typically being 
the downsampled 463m/pixel MOLA DTM for Mars). The above differences are illustrated in 
Figure 1, where we show a simplified flow diagram of the photogrammetric DTM pipeline and 
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the deep learning-based single-image DTM pipeline (e.g., MADNet). See (Tao et al., RS, 
2021c) for more details. 

 
 Figure 1.  Illustration of the major differences between the photogrammetric DTM pipeline and the deep 
learning-based single-image DTM pipeline (e.g., MADNet) discussed here. Taken from (Tao et al., RS, 
2021d). 

 
1.1 Instrument and Datasets 
We focus on the Oxia Planum area, where the joint European Space Agency (ESA) and Russian 
Roscosmos ExoMars mission will land the ESA “Rosalind Franklin” rover and the Roscosmos 
landing platform “Kazachok” in 2023. Large area high-resolution DTM mosaics, covering the 
3-sigma landing ellipses, are produced here at 25m/pixel for HRSC, 12m/pixel for CTX, and at 
50cm/pixel for HiRISE. Cascaded 3D co-alignments (HRSC-to-MOLA, CTX-to-HRSC, and 
HiRISE-to-CTX) have been achieved (ibid.) to guarantee precise global congruence with 
respect to MOLA. Part of this area has been used for the Jet Propulsion Laboratory webGIS 
(web based Geographic Information System) called MMGIS (Multi-Mission Geographic 
Information System) to assist the ExoMars team’s geological characterisation of the area. 
 
In this work, a total of 12 CTX images (6 serendipitous pairs) and 44 HiRISE images are used 
(both are manually selected using a list from the PDS product coverage shapefiles to cover the 
3-sigma landing ellipses and partially the ExoMars team’s geological characterisation area. The 
input HiRISE images are manually selected for quality, while keeping sufficient overlaps 
within neighbouring scenes in order to produce a single uniform quality and gap-free DTM 
mosaic. The 25cm/pixel images have a priority over 50cm/pixel images if both cover the same 
area. Some HiRISE images that contain severe framelet-stitching artefacts or missing data are 
excluded. New images are also checked to fill remaining DTM gaps at the end of the process. 
It should be noted that there are many more images that exist then are available other than the 
selected CTX and HiRISE images for this work. 
 
An overview of the area covered, and the input MOLA-HRSC-CTX-HiRISE datasets, are shown 
in Figure 2. The yellow boxes in Figure 2 represent the coverage of the available HiRISE 
images (up until NASA’s last released images on 09 June 2021) within the 3-sigma landing 
ellipses, where the yellow boxes with hatched fill are HiRISE images with off-nadir 
counterparts and the plain yellow boxes are HiRISE images without any repeat observations 
(i.e., only single views are available). As the proposed method only requires single images as 
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inputs, the 3D mapping area for HiRISE can be greatly enlarged to cover other areas without 
any targeted or serendipitous observations being available. 

 
Figure 2.   An overview of the proposed 3D mapping area at Oxia Planum (centred at 18.239°N, 24.368°W), 
showing the ESA Rosalind Franklin rover 2022 1-sigma (red) and 3-sigma (green) landing ellipse areas and the 
ExoMars team’s geological characterisation area (blue). Shown in the background are the co-registered input 
datasets of MOLA DTM (colourised and hill-shaded), cropped HRSC MC-11W level 5 ORI greyscale mosaic, CTX 
ORI mosaic, and HiRISE image footprints (in yellow; with hatched outlines referring to those available with off-
nadir stereo; the footprints are relevant to the NASA release data of 09 June 2021). Taken from (Tao et al., 
RS, 2021d) 

 
 
1.2 Abbreviations and Acronyms 
 
DTM   Digital Terrain Model 
DUG   Data User Guide 
ESA   European Space Agency 
GIS   Geographic Information System 
HRSC   High-Resolution Stereo Camera 
CTX  Context camera 
HiRISE High Resolution Imaging Science Experiments 
MOLA   Mars Orbiter Laser Altimeter 
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NASA   National Aeronautics and Space Administration (United States)  
ORI   OrthoRectified Images 
PSA   Planetary Science Archive 
UCL   University College London 
 
1.3 Reference and Applicable Documents  
 
Tao, Y.; Muller, J. P.; Sidiropoulos, P.; Xiong, S.-T.; Putri, A. R. D.; Walter, S. H. G.; Veitch-
Michaelis, J.; Yershov, V. Massive Stereo-based DTM Production for Mars on Cloud 
Computers. Planetary Space Science 2018, 154, 30–58.doi: 10.1016/j.pss.2018.02.012 
 
Tao, Y.; Michael, G.; Muller, J.-P.; Conway, S. J.; Putri, A. R. D. Seamless 3D Image Mapping 
and Mosaicing of Valles Marineris on Mars Using Orbital HRSC Stereo and Panchromatic 
Images. Remote Sensing 2021a, 13, 1385.doi: 10.3390/rs13071385 
 
 Tao, Y.; Conway, S. J.; Muller, J.-P.; Putri, A. R. D.; Thomas, N.; Cremonese, G. Single Image 
Super-Resolution Restoration of TGO CaSSIS Colour Images: Demonstration with 
Perseverance Rover Landing Site and Mars Science Targets. Remote Sensing 2021b, 13, 1777. 
doi: 10.3390/rs13091777 
 
Tao, Y.; Xiong, S.; Conway, S.J.; Muller, J.-P.; Guimpier, A.; Fawdon, P.; Thomas, N.; 
Cremonese, G. Rapid Single Image-Based DTM Estimation from ExoMars TGO CaSSIS Images 
Using Generative Adversarial U-Nets. Remote Sens. 2021c, 13, 2877. 
https://doi.org/10.3390/rs13152877 
 
Tao, Y.; Muller, J.-P.; Conway, S.J.; Xiong, S. Large Area High-Resolution 3D Mapping of Oxia 
Planum: The Landing Site for the ExoMars Rosalind Franklin Rover. Remote Sens. 2021d, 13, 
3270. https://doi.org/10.3390/rs13163270 
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2. SCIENTIFIC OBJECTIVES 

All results shown here are made for the Rosalind Franklin ExoMars 2022 rover’s landing site 
at Oxia Planum. This site is a 200 km wide clay bearing plain centred on 18.239° N, 24.368° 
W (see Figure 2) inside the United States Geological Survey (USGS)’s Oxia Palus (MC-11) 
quadrangle of Mars. The landing site area straddles the dichotomy boundary of Mars, which 
separates the northern lowlands from the southern highlands. The site slopes towards the 
north and hosts mineralogical (iron-magnesium rich clay minerals) and geomorphological 
evidence of liquid water in the ancient past, which motivated the choice of this site for this 
mission whose principal objective is to search for potential biomarkers indicating past life on 
Mars. 
 
2.1 Acknowledgements 
Users are requested to acknowledge the dataset by mentioning it in any relevant figure captions 
and within acknowledgement within their publications to cite both the DOI of the dataset and 
the paper describing the processing system, assessment, and mosaic generation: 
 
Tao, Y.; Muller, J.-P.; Conway, S.J.; Xiong, S. Large Area High-Resolution 3D Mapping of Oxia 
Planum: The Landing Site for the ExoMars Rosalind Franklin Rover. Remote Sens. 2021, 13, 
3270. https://doi.org/10.3390/rs13163270 
 
Tao, Y.; Xiong, S.; Conway, S.J.; Muller, J.-P.; Guimpier, A.; Fawdon, P.; Thomas, N.; 
Cremonese, G. Rapid Single Image-Based DTM Estimation from ExoMars TGO CaSSIS Images 
Using Generative Adversarial U-Nets. Remote Sens. 2021, 13, 2877. 
https://doi.org/10.3390/rs13152877 
 
The research leading to these results is receiving funding from the UKSA Aurora programme 
(2018–2021) under grant ST/S001891/1, as well as partial funding from the STFC MSSL 
Consolidated Grant ST/K000977/1. 
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3. DATA PRODUCT GENERATION 

The processing core of this work is the MADNet deep learning based single-image DTM 
estimation system described in (Tao et al., RS, 2021c). MADNet is based on the Generative 
Adversarial Network (GAN) framework. In particular MADNet is based on a multi-scale 
relativistic GAN architecture, which was previously developed for image super-resolution 
tasks. MADNet operates by training a generative model for relative height prediction, and in 
an alternating manner, updating a discriminator model to distinguish the predicted heights 
from the normalised ground-truth heights. 
 
The MADNet generator network uses a three-scale U-Net based architecture. Each of the three-
scale U-Nets (the coarse-scale, intermediate-scale, and fine-scale) consists of a dense 
convolution block (DCB) based encoder arm and an up-projection block (UPB) based decoder 
arm. The fine-scale U-Net contains five stacks of convolutional layers, pooling layers, and 
DCBs to encode the input image into a feature tensor, which is then fed into five stacks of UPBs 
and convolutional layers with concatenations of the corresponding outputs of each pooling 
layer to decode the feature vectors into the output height map. The intermediate-scale and 
coarse-scale U-Nets take two times and four times downsampled input images and use four 
and three stacks of the convolution-pooling-DCB and UPB-convolution layers to reconstruct 
the height maps in two times and four times coarser scales, respectively. 
 
Outputs from the three-scale U-Net networks are then merged with adaptive weights to 
reconstruct the final output height map (relative height). A simplified network architecture of 
the MADNet generator can be found in Figure 3 for a detailed description (including the 
discriminator network), please refer to (Tao et al., RS, 2021a). 

 
Figure 3.    Overview of the MADNet generator network architecture. The input image has a size of 512 × 512 
pixels and the final output height map has a size of 256 × 256 pixels in a relative value range of (0, 1). 

 
In this work (Tao et al., RS, 2021c), MADNet is employed alongside 3D co-alignment and 
DTM mosaicing methods to produce co-aligned DTM mosaics using a set of co-registered 
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HRSC-CTX-HiRISE images over the landing site area. The overall processing chain of the work 
described here is shown in Figure 4. 

 
Figure 4.  Overall processing chain of the large area multi-resolution (HRSC-CTX-HiRISE) 3D mapping work. 
Inputs are shown with the light orange boxes, intermediate products with the light blue boxes, and final outputs 
are shown with the light green boxes. 

 
The inputs of the proposed large area multi-resolution 3D mapping work are the 463m/pixel 
MOLA areoid DTM (available at 
https://astrogeology.usgs.gov/search/details/Mars/GlobalSurveyor/MOLA/Mars_MGS_M
OLA_DEM_mosaic_global_463m/cub), the 50m/pixel HRSC MC-11W (Mars Chart-11 West) 
level 5 DTM mosaic and 12.5m/pixel ORI mosaic (available at 
http://hrscteam.dlr.de/HMC30/MC11W/), the 6m/pixel CTX stereo-view images (accessible 
through the Arizona State University’s Mars Image Explorer at 
http://viewer.mars.asu.edu/viewer/ctx), and the 25–50cm/pixel HiRISE single-view 
(monocular) images (available through the University of Arizona’s HiRISE site at 
https://hirise-pds.lpl.arizona.edu/PDS/). The CTX and HiRISE image IDs that cover the 
landing site area were found through the product coverage shapefile site 
(https://ode.rsl.wustl.edu/mars/coverage/ODE_Mars_shapefile.html).  
 
The overall processing chain includes 11 steps (labelled in Figure 3) and can be summarised 
as follows: 
1) B-spline fitting based on 3D co-alignment of the input (cropped) HRSC MC-11W level 5 

DTM mosaic with respect to the input MOLA DTM to obtain an intermediate 50m/pixel 
MOLA corrected HRSC DTM mosaic. 

2) MADNet DTM production, using the cropped HRSC MC-11W level 5 ORI mosaic as input 
to produce an intermediate 25m/pixel HRSC DTM mosaic. 

3) 3D co-alignment of the intermediate 25m/pixel HRSC DTM mosaic from step (2) and the 
intermediate 50m/pixel MOLA-co-aligned HRSC DTM mosaic from step (1), to produce 
the 25m/pixel MOLA-co-aligned HRSC DTM mosaic, which is the first of the three final 
products of this work.  

4) CASP-GO photogrammetric DTM production of CTX serendipitous “stereo” images to 
produce 18m/pixel CTX DTMs, which are co-aligned with the 25m/pixel MOLA-co-aligned 
HRSC DTM mosaic from step (3), as well as 6m/pixel CTX ORIs, which are co-registered 
with the input 12.5m/pixel HRSC MC-11W level 5 ORI mosaic. 
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5) MADNet DTM production using the intermediate 6m/pixel HRSC-co-registered CTX ORIs 
from step (4) to produce intermediate 12m/pixel CTX DTMs.  

6) 3D co-alignment of the intermediate 12m/pixel CTX DTMs from step (5) and the 18m/pixel 
HRSC-co-aligned CTX DTMs from step (4) to produce 12m/pixel HRSC-co-aligned CTX 
DTMs. 

7) DTM mosaicing (using the NASA Ames Stereo Pipeline “dem_mosaic” function) of the 
12m/pixel HRSC-co-aligned CTX DTMs from step (6) to produce a 12m/pixel HRSC-co-
aligned CTX DTM mosaic, which is the second of the three final products of this work. 

8) Image co-registration (using the mutual shape adapted scale invariant features) of the 
input 25-50cm/pixel HiRISE images with respect to the 6m/pixel HRSC-co-registered CTX 
ORIs from step (4).  

9) MADNet DTM production using the CTX-co-registered HiRISE images from step (8) to 
produce intermediate 50cm/pixel HiRISE DTMs. 

10) 3D co-alignment of the intermediate 50cm/pixel HiRISE DTMs from step (9) and the 
12m/pixel HRSC-co-aligned CTX DTM mosaic from step (7) to produce CTX-co-aligned 
50cm/pixel HiRISE DTMs. 

11) DTM mosaicing of the 50cm/pixel CTX-co-aligned HiRISE DTMs from step (10) to 
produce a 50cm/pixel CTX-co-aligned HiRISE DTM mosaic, which is the third of the three 
final products of this work. 
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4. ARCHIVE FORMAT AND CONTENT 

4.1 Product Type 
The final outputs of the mapping work include a 25m/pixel HRSC DTM mosaic covering 
about a 197km×182km area of the landing site (see Figure 5), a 12m/pixel CTX DTM mosaic 
covering about a 114km×117km area of the landing site (see Figure 6), and a 50cm/pixel 
HiRISE DTM mosaic (see Figure 7) covering about a 74.3km×86.3km area of the 3-sigma 
landing ellipses and partially the ExoMars team’s geological characterisation area. It should 
be noted that all final outputs are 3D co-aligned with the reference MOLA DTM using the B-
spline fitting based 3D co-alignment method. The complete set of Oxia Planum DTM mosaic 
products for each of the HRSC, CTX, and HiRISE instruments contains the following types of 
products: 
• DTM mosaic (Mars areoid) 
• single-strip ORIs 

 
Figure 5. Coverage of the MADNet 1.0 HRSC 25m DTM showing showing the 1-sigma (in red) and 3-sigma (in 
green) landing ellipse as of the date of this document and the geological mapping area (in blue). 
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Figure 6. Colourised and hill-shaded CTX MADNet 12m DTM superimposed on top of HRSC MADNet 1.0 25m 
DTM showing the 1-sigma (in red) and 3-sigma (in green) landing ellipse as of the date of this document and the 
geological mapping area (in blue). 

  



ESA UNCLASSIFIED - For Official Use 
 
 
 

Page 14/17 
  

Figure 7. HiRISE MADNet 1.0 0.5m DTM superimposed on MADNet 1.0 CTX 12m DTM superimposed on 
MADNet 1.0 HRSC 25m DTM all using the same colour hill-shaded parameters with reduced colour for the 
HiRISE showing the 1-sigma (in red) and 3-sigma (in green) landing ellipse as of the date of this document and 
the geological mapping area (in blue). 

 
Filename  
(see further details below the table) 

Grid 
m 

NS NL Size 
(Gb) 

Top-left 
lon,lat 
extent 

Bottom-
right 
lon,lat 

MOLA_463m_OXIA_CROP_HRSC-Proj.tif 
(1) 

463 663 519 - 26.030W 
19.772N 

22.706W 
16.706N 

HRSC-OxiaPlanum-MADNet-DTM.tif (2) 25 7880 7270 0.131 26.030W 
19.772N  

22.706W 
16.706N 

HMC_11W24_ND5_OXIA_CROP.tif (3) 12.5 15991 14711 0.235 - “ - - “ - 
CTX-OxiaPlanum-MADNet-DTM.tif (4) 12 9501 9771 0.128 25.366W 

19.116N 
23.443W 
17.138N 

CTX-ORIs/*.tif   (∑=6) (5) 6 - - 2.1 - “ - - “ - 
HiRISE-OxiaPlanum-MADNet-DTM-
mosaic44.tif (6) 

0.5 148697 172508 18 24.922W, 
18.865N 

23.668W 
17.409N 

HiRISE-ORIs/*.tif  (∑=44) (7) 0.25 - - 76.9 - “ - - “ - 

 
N.B. 

1. The 463m/pixel PDS MOLA global areoid DTM, cropped for the Oxia Planum area 
and reprojected using the same projection system as the 12.5m/pixel ESA/DLR/FU-
Berlin HRSC MC-11W products 

2. The 25m/pixel MADNet HRSC DTM mosaic co-aligned with MOLA 
3. The 12.5m/pixel ESA/DLR/FU-Berlin HRSC MC-11W level 5 ORI mosaic cropped for 

the Oxia Planum area 
4. The 12m/pixel MADNet CTX DTM mosaic co-aligned with the 25m/pixel MADNet 

HRSC DTM mosaic over Oxia Planum 
5. The 6m/pixel UCL CTX single-strip ORIs co-registered with the 25m/pixel MADNet 

HRSC DTM mosaic over Oxia Planum 
6. The 50cm/pixel MADNet HiRISE DTM mosaic co-aligned with the 12m/pixel 

MADNet CTX DTM mosaic over Oxia Planum 
7. The 25cm/pixel HiRISE single-strip images, map-projected to MOLA and co-

registered with the 6m/pixel UCL CTX single-strip ORIs over Oxia Planum. 
 
4.2 DTM/ORI Specification 
• Projection: Equirectangular 1 
• Mars radius reference: MOLA aeroid (da) 2 
 
4.3 Product Example and Usage 
The DTM and ORI file in GeoTiff format can be opened in GIS/image processing software 
such as ArcGIS, QGIS, and ENVI. Projection and mapping information is embedded in the 
header of the Geotiff file. 
The best way to visually inspect a DTM is via a colourised hill-shaded display. The following 
instructions show how to create a colourised hill-shaded view of the DTM product in QGIS. 

 
1 https://en.wikipedia.org/wiki/Equirectangular_projection  
2https://astrogeology.usgs.gov/search/map/Mars/GlobalSurveyor/MOLA/Mars_MGS_MOLA_DEM
_mosaic_global_463m  
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1. Import the DTM via: Layer -> Add layer -> Add Raster Layer -> Select the Raster 
dataset(s) -> Add -> Close 

2. Create shaded relief image: left click to select the DTM -> Raster -> Analysis -> 
Hillshade -> Select the illumination parameters (e.g., z=2, azimuth=330, 
elevation=30) under “Hillshade”  click “…” -> save to file -> choose a filename and 
end with .tif -> OK -> run -> close 

3. Adjust the display setting of the shaded relief image: right click the hill-shaded relief 
image -> Properties -> Symbology -> under “Color Rendering” select “Blending 
mode” -> “Overlay” -> adjust “Brightness” as “-60” -> Apply -> OK. 

4. Adjust the display setting of the DTM: right click the DTM -> Properties -> 
Symbology -> under “Band Rendering” select “Render type” as “Singleband 
pseudocolor” -> under “Min/Max Value Settings” select Min/Max -> under “Color 
ramp” select a colour ramp then select “Invert Color Ramp” -> click “Classify” -> 
Apply -> OK 

 
Other important notes: 
1. Put the hillshaded relief image layer in front of the colourised DTM layer. 
2. Do not use transparency for the hillshaded relief image layer as “Overlay” display 

mode is already selected. 
3. You can use z=3 if a strong hill-shading effect is needed. 
4. Always create a group for the colourised DTM and hillshaded relief image, and use the 

group icon to toggle display of the colourised hillshaded DTM. 
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5. KNOWN ISSUES 

The resultant 50cm/pixel HiRISE MADNet DTM mosaic has some known artefacts. These 
include the tiling artefacts, smoothing issues, DTM gaps due to insufficient overlap of HiRISE 
images, and linear artefacts due to missing data within the HiRISE image (only found in 
strips). Figure 8  provides an example for each of the four known artefacts within the hill-
shaded images and show how much they would affect the DTMs. The affected areas are 
considered minor (less than 0.2% of the total number of pixels) within the mosaic. It should 
also be noted that the HRSC and CTX MADNet DTM mosaics do not have any of these 
artefacts. 

 
Figure 8.  Examples of known artefacts of the HiRISE MADNet DTM mosaic, i.e., 1st column: tiling artefacts; 2nd 
column: smoothing issues; 3rd column: missing columns in the original HiRISE image; 4th column: linear 
artefacts due to the use of JPEG2000 HiRISE images that do not have the correct radiometric de-calibration. 
Hill-shaded image is created using the HiRISE MADNet DTM mosaic with illumination azimuth 330˚, elevation 
30˚, and a vertical exaggeration factor of three times. 
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6. SOFTWARE 

The processing uses the UCL’s in-house MADNet 1.0 single-image DTM estimation system. 
 
 
 
 
 


